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Overview of Corticon installations

This guide presents procedures for accessing, downloading, and running Corticon 6.0 installers, as well as
providing dynamic access to information about supported platforms. Links to the Progress Corticon
KnowledgeBase provide additional information about third-party software setup.

Progresse Corticone is the Business Rules Management System with the patented rules engine that enables
you to automate sophisticated decision processes—without having to write code.

Progress Corticon products

Progress Corticon distinguishes its development toolsets from its server deployment environments.

Corticon Studio is the Windows-based development environment for creating and testing business rules:

When installed as a standalone application, Corticon Studio provides a complete Eclipse development
environment for Corticon in the Corticon Designer perspective. You can use this Eclipse installation
as the basis for adding other Eclipse tools.

When installed into an appropriate existing Eclipse environment, Corticon integrates with installed Eclipse
tools to enable you to develop Corticon applications in the Corticon Designer perspective.

Note: Refer to Installing Corticon Studio plugins into an existing Eclipse on page 22 for details about
integrating Corticon Studio into an existing Eclipse environment.

Corticon Servers implement web services and in-process servers for deploying business rules defined in
Corticon Studio:

* Corticon Server for Java is supported on various application servers, and client web browsers. After
you install it on a supported Windows platform, its deployment artifacts can be redeployed on various

UNIX and Linux web service platforms as Corticon Decision Services.
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Chapter 1: Overview of Corticon installations

* Corticon Server for .NET facilitates deployment of Corticon Decision Services on Windows .NET
Framework and Microsoft Internet Information Services (lIS).

* Corticon Web Console enables administration of multiple remote Corticon Servers. A Web Console
server is deployed into an application server, and then is accessed by users through authenticated web
browser connections.

For details, see the following topics:

* System requirements

* Downloading Corticon installer packages

System requirements

Progress Corticon products are supported on a variety of platforms and third-party components.

Corticon Studio

Refer to the Progress Software web page Progress Corticon 6.0 - Supported Platforms Matrix to review the
currently supported Corticon Studio operating systems, and Eclipse versions.

The target system for a Corticon Studio installation requires:
* Supported Windows operating system

* 8 GB System RAM (minimum of 2 GB available RAM)

* 650 MB disk space

*  When an existing Eclipse will be used, a supported Eclipse version

Corticon Server for Java

Refer to the Progress Software web page Progress Corticon 6.0 - Supported Platforms Matrix to review the
currently supported platforms and application servers. Also see the Corticon KnowledgeBase entry Corticon
Server 6.X sample WAR installation for different Application Servers for detailed instructions on configuring
Apache Tomcat, JBoss, WebSphere, WebLogic, and Wildfly on all supported platforms.

The target system for a Corticon Server for Java installation requires:

* Supported Windows or Linux operating system

* When deploying on other platforms, a supported operating system and application server
* 8 GB System RAM (minimum of 2 GB available RAM)

* 600 MB disk space

Corticon Server for .NET

Refer to the Progress Software web page Progress Corticon 6.0 - Supported Platforms Matrix for information
on supported .NET Framework and IS versions, and the Corticon Knowledgebase article appropriate for your
target IIS/platform, as listed in the topic Setting up Corticon .NET Server resources on an IS server on page

33.

The target system for a Corticon Server for .NET installation requires:
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Downloading Corticon installer packages

¢ Supported Windows operating system

* Supported .NET Framework and Internet Information Service (IIS)
* 8 GB System RAM (minimum of 2 GB available RAM)

* 500 MB disk space

Corticon Web Console

Refer to the Progress Software web page Progress Corticon 6.0 - Supported Platforms Matrix for information
on supported browser versions.

The target system for a Corticon Web Console installation requires:
* Supported Windows or Linux operating system

* 4 GB System RAM (minimum of 2 GB available RAM)

¢ Java option for MaxPermSize set to at least 256m

* 600 MB disk space

Note: When all three Server components are installed on one machine, the required space for the installation
is about 1 GB.

Downloading Corticon installer packages

The Corticon Studio installer package
For supported Windows machines: PROGRESS CORTICON 6.0 STUDIO WIN 64.exe

The Corticon Server and Web Console packages
Microsoft Windows

Corticon Server and Web Console 6.0 products for Windows -- Java Server, .NET Server, and Web Console
-- are packaged in executable installer applications and ZIP archives.

For supported Windows machines, download: PROGRESS CORTICON 6.0 SERVER WIN 64.exe
Zip Archives

Corticon Server and Web Console .war files are available in a Corticon Server .zip archive. Use it to install the
Web Console on a supported application server without using the executable installers.

Linux

Corticon Server and Web Console 6.0 products for Linux -- Java Server, and Web Console — are packaged in
executable installer applications for supported Linux machines:
PROGRESS CORTICON 6.0 SERVER LNX 64.bin

Perform downloads

To download required Corticon installers:

Progress Corticon : Installation 9


https://documentation.progress.com/output/Corticon/6.0.0/redirectors/supported-platforms.html

Chapter 1: Overview of Corticon installations

1. Get credentials to access and download packages on the Progress Software Electronic Software Download
(ESD) site, .

2. Connect to the ESD, log in, and then navigate to the Corticon 6.0 page.

3. Locate, download, and save the required installers to a temporary location accessible by the target machine.
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Preparing for a Corticon installation

Before running installers

To avoid possible constraints on the installers, do the following:

Confirm that you have Administrator permissions on the target machine - Administrator rights allow
the installer to copy all the Corticon files to their proper locations. You must have Administrator rights and
permissions to install this software. See your system administrator to obtain these rights.

Obtain system access - Several Corticon features write files to the “home” directory structure. If the target
machine for the Corticon installation does not have read and write access to this directory, you need to
choose a directory location where Corticon will have both read and write access.

Disable anti-virus, anti-malware, and anti-spyware protection applications - Before performing the
installation, consider temporarily disabling any anti-virus and anti-spyware software that may be running on
the target machine, as such software might interfere with correct installation.

Review the supported platforms - Refer to the Progress Software web page Progress Corticon 6.0 -
Supported Platforms Matrix to review the operating system versions for Corticon Server and Corticon Studio
and supporting software.

For details, see the following topics:

If you are evaluating Corticon

If you are upgrading Corticon

If you are evaluating Corticon

You can install Studio and Server, start them, and then get underway. The licensing will sustain you for a while:

Progress Corticon : Installation
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Chapter 2: Preparing for a Corticon installation

¢ Studio Licensing - Corticon embeds a ninety-day evaluation license that enables development of business
rules projects, as well as testing of the projects in an embedded test server. You must obtain Studio
development licenses from your Progress representative.

e Server Licensing - Corticon embeds a limited evaluation license that enables testing of rule modeling
projects on all supported platform configurations except .NET. You must obtain server deployment licenses
and .NET evaluation licenses from your Progress representative. The license included in the default Corticon
Server installation has pre-set limits on certain Corticon Server and Decision Service parameters. These
limits are:

* Number of Decision Services — Up to 20 Decision Services may be deployed at any given time. This
means the sum total of all Decision Services loaded via . cdd files, Web Console, or APIs cannot exceed
20.

* Number of Rules — All rules in all deployed Ruleflows (that is, all deployed Decision Services) must not
exceed 500. A rule generally consists of a single Condition/Action Column or a single Action row in
Column 0. Filter expressions do not count because they only modify other rules.

Note: The Corticon Server log can capture errors and exceptions caused by expired or under-strength
licenses. These log messages are detailed in the Using Corticon Server logs section of the Server Guide.

If you are Progress Corticon customer, you should have access to an unlimited license that will lift these
restrictions. If you are an evaluator, and discover that these limitations are preventing or inhibiting your
evaluation, contact your Progress Software representative to get a license with expanded capabilities. For
information on installing an updated license in Studio or Server, see the related topics in Procedures for
upgrading Corticon installations on page 12.

If you are upgrading Corticon

Existing Corticon users advancing to this release will want to know whether their existing products can co-exist
with the newer version, as well as any strategies for perpetuating the assets created in their current version.

Procedures for upgrading Corticon installations

Stepping through tasks that optimize upgrades of Corticon Studios and Servers ensures that your files and
assets are synchronized with the updated product. These tasks are a checklist of good practices.

If your upgrade was a minimal step forward, such as a patch (such as 5.6.0.11 > 5.6.0.12), you should read
the patch notes to see if there are tasks to consider. For a Service Pack (such as 5.7.0 > 5.7.1), it is more likely
that there are changes in the product that you should handle, even though they might not present problems.
For a minor release -- especially a big step (such as 5.5.2 > 6.0.0) -- every one of these tasks should be
reviewed, considered, and performed.

Note: Do not copy a .war or .ear file from an older version's installation to a new one.

In the order of action:
ON STUDIO MACHINES
* Update Studio installations

* Update the Studio's brms.properties
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If you are upgrading Corticon

Update eclipse.ini and Java
Update the Studio license file
Upgrade assets

Update desktop shortcut

Repackage Decision Services

ON SERVER MACHINES

Undeploy the old Decision Services

Update Corticon Server and Web Console software
Update the Server license files

Update the Server's brms.properties

Clear browser caches that use the Web Console
Update IIS servers and set clienttype to 1IS

Deploy regenerated Decision Services

Stop load balancers and start the new server

ON STUDIO MACHINES

Install Studios

See Installing Corticon Studio on page 17

Update the Studio's brms.properties

Compare the brms . properties files that are currently in use. Any property adjustments you made in the
past, if still valid, should be copied into the newer installation. While a minor release installs into a separate
location, a service pack overlays an existing installation and does not touch an existing brms .properties .

On .NET servers, you can copy the brms . properties file from the Corticon server root, paste it adjacent to

the axis.war in the IIS location, and thereafter apply updates to it.

Update eclipse.ini and Java

Some Studio installations benefit from tweaking the eclipse. ini, often for Studio memory settings section
of the Corticon Installation Guide. If you are pointing to your preferred Java, it might not be optimal.

Update the Studio license file
A maijor release will likely require a new license file while minor releases typically do not. When you are provided
a license for Corticon Studio and Server, you receive a JAR file, CcLicense. jar. Save the file on the target
machine or at a location that is network-accessible to the installation. In this example, the license file that both
Studio and Server will use is placed at C:\1icenses.

Progress Corticon : Installation
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Chapter 2: Preparing for a Corticon installation

To update a Studio license:

1. Select the menu command Window > Preferences.

2. Expand the Progress Corticon group. In the License File entry area, enter or browse to the location of
the license JAR:

& Preferences O X

type filter text Progress Corticon ST v
General

General Progress Corticon Settings:
Ant g g

Help

Install/Update Override Properties File: l:l Browse...
Java

Model Validation

Plug-in Development License File: | Browse...

Progress Corticon
Run/Debug
Team

License Information:
Progress Corticon Studio
Viewruleflow Diagram Version: 6.0.0.0 -b10018
Licensed to: Evaluation
EDC Enabled: Yes
Expires in 90 days.

Restore Defaults Apply
'?}' I\_‘ B3 Apply and Close Cancel

Click Apply, and then click OK.

Upgrade assets

In Studio, be sure to upgrade all project assets. While you could do this file by file or project by project, itis a
good idea to advance all the assets you might work with in the current release. It is a good idea to run any
Ruletest or unit tests to see that the behaviors are as expected.

Update desktop shortcut
Make changes to your desktop shortcut if you want your new Studio version to run in a different language.

Repackage Decision Services

Use any of the several techniques in Studio to package projects as Decision Services, and then stage them
for deployment on the new server installations.

ON SERVER MACHINES

Undeploy old Decision Services

Undeploy every EDS on the target servers.

Install new Corticon Server and Web Console software

If you are using load balancers to carry the load during upgrade, take one of its peers offline, and stop it. Run
the installers, and then start the new Server.

14
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If you are upgrading Corticon

Note: Other application servers - The .war files can be downloaded in the

PROGRESS CORTICON 6.0 SERVER.zip package. The unpackaged files are typically installed in the Corticon
directory [CORTICON HOME]\Server\Containers\WAR. Referto the Progress Software web page Progress
Corticon 6.0 - Supported Platforms Matrix to review the currently supported UNIX/Linux platforms and brands
of application servers. Also see the Corticon KnowledgeBase entry Corticon Server WAR installation for
different Application Servers for detailed instructions on configuring JBoss, WebSphere, WebLogic, and Wildfly
on all supported platforms.

Update Server licenses
The Server requires you to copy the CcLiense. jar file, and then paste it to replace the existing file, as follows:
* Java server license:

* [CORTICON HOME]\Server\1lib\The license used for Server tasks and operations.

* [CORTICON HOME]\Server\tomcat\webapps\axis\WEB-INF\1libThe license deployed to the
runtime server. If you are managing a default Java server from the Web Console, you can perform this
task through its "Editing Servers” in the Web Console Guide.

*  When your installation is from the . war file for deployment onto other supported platforms and application
servers, place the license file adjacent to the Corticon JARs.

* _NET server license :

Note: You must have a license issued to you that enables .NET server to work with Corticon. See Knowledge
Base article 96997

* [CORTICON HOME]\Server .NET\ThirdParty\lib\The license propagated to the IIS location by
the install utility.

* The lIS location, typically: C:\inetpub\wwwroot\axis\1ib\The license at the IIS location. If you
are managing a .NET server from the Web Console, you can perform this task through its "Editing
Servers" in the Web Console Guide.

Update the Server's brms.properties

As with Studio, compare and update the brms . properties files on Java and .NET servers with consideration
that many properties are effective only on servers.

Clear browser caches that use the Web Console

For administrators that use the Web Console, have them flush their browser caches.

For .NET servers:

* Install to the lIS - Run install.bat to refresh the IIS server's libraries and samples. Answer Y to all the
overwrite choices. Then restart the IIS server.

* Set the Client Type - Change the setting in the brms . properties file that enables the Studio remote
tests and server utilities:

com.corticon.studio.client.soap.clienttype=IIS
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Chapter 2: Preparing for a Corticon installation

Deploy the fresh Decision Services

Deploy the newly created Decision Services to the new server.

Note: When using CDDs, be aware that you might have two types of data access configuration files. The
legacy format used a .properties file while new format is a datasources.xml file.

* Where you have a legacy .properties file with EDC, use CDD Property :

PROPERTY DATABASE ACCESS PROPERTIES PATH

* Where you are have a new style . xm1 file, use CDD Property :

PROPERTY DATASOURCE CONFIG FILE PATH

Stop load balancers and start the new server

Use Web Console (or other techniques) to deploy the upgraded EDS files and license to the new Server. Bring
the other load balancers down, and then expose the upgraded server to carry the load. Uninstall old Servers,
and then upgrade and provision to be peers.
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Installing Corticon Studio

There are several techniques for installing Corticon Studio:

Running the Corticon Studio installer wizard on page 18, the typical use, which enables a complete Corticon
Studio Eclipse installation that can standalone, or be tailored into another Eclipse IDE on the same machine.

Performing silent installations of Studio on page 22 that generates a file from an installer wizard run to let
you perform silent Studio installations on other machines.

Installing Corticon Studio plugins into an existing Eclipse on page 22 which enables scripted installation of
Corticon Studio plugins into an existing Eclipse.

What Corticon Studio installers provide

The installer wizard package includes:

Corticon Studio resources

Eclipse Development Environment and Eclipse online documentation.
Java Runtime Environment (JRE)

Sample projects

API documentation for extending Corticon

Corticon Server runtime for use in testing rules you create in Corticon Studio
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Chapter 3: Installing Corticon Studio

Installation options

A new Corticon Studio install lets you choose to install it standalone, or to add its plugins to an existing Eclipse
4.8 installation.

For details, see the following topics:

*  Running the Corticon Studio installer wizard

*  Performing silent installations of Studio

* Installing Corticon Studio plugins into an existing Eclipse
* Increasing Corticon Studio memory allocation

*  Setting Studio to run in another language

Running the Corticon Studio installer wizard

The Studio installer will install or update Studio 6.0.

Installing or updating Studio 6.0

To perform a new installation of Corticon Studio 6.0:

1. Double click on the installer file, PROGRESS CORTICON 6.0 STUDIO WIN 64.exe, tolaunch the Corticon
Studio installer.

The installer opens in the installer wizard.
2. The first installer panel opens with information about the installer.

Progress Corticon Studic 6.0.0.0 = it

Introduction

;‘h Progress‘ InstallAmywhere will guide you through the installation of Progress
Corticon Studio.

Itis stronaly recormmended that you quit all programs before
continuing with this installation.

Progress _
. & Click the ™ext' button to proceed to the next screen. Ifyou want to
COFTICOF’I change something on a previous screen, click the 'Previous’ button.

rr"Tl "j. You may cancel this installation at any time by clicking the 'Cancel’
= "J C “"'] hutton

Cancel Previous
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Running the Corticon Studio installer wizard

Note: If Corticon Studio 6.0 is installed at any location on the target machine, an alert is posted that denies
permission to continue, as shown:

Error. Progress Corticon Studic already installed *

|@| Progress Corticon Studio 6.0.0.0 is already installed on
"% your computer. To reinstall Progress Corticon Studio
6.0.0.0, first uninstall the existing 6.0.0.0 installation.

Flease Uninstall Progress Corticon Studio and try installing again.

You will be able to apply 6.0 Studio service packs and patches. You can have other versions of Corticon
Studio installed in distinct folders and they can run concurrently, although they must keep their workspaces
separate.

3. Click Next to continue.

The License Agreement panel opens.

Progress Corticon Studio 6.0.0.0 = >
License Agreement

ﬁl Pro.gress' Installation and Use of Progress Corticon Studio Requires
Acceptance of the Following License Agreement:

End Uszer License Asresment

Progress”

Corticon” CAUTION: YOU SHOULD CAREFULLY READ THE FOLLOWING
TERMS AND CONDITIONS OF THIS end user license AGREEMENT
e i EEFORE INSTALLING OR USING THE PRODUCT AND
Studio DOCUMENTATION TO WHICE THIS AGREEMENT RELATES. BY
ACCEPTING THIS AGREEMENT YOU ARE CONSENTING TO BE
BOUND BY THE TERMS AND CONDITIONS CONTAINED
HEREIN AND ACKNOWLEDGING YOUR AUTHORITY TO DO S0 ON
BEHALF OF YOUR COMPANY (IF APPLICABLE). IF YOU DO NOT
AGREE WITH THESE TERMS AND CONDITIONS, DO NOT PROCEED

@ 1 scoept the terms of the License Agresment

(:) | do MOT accept the terms of the License Agreement

This panel displays the Progress Software End User License Agreement (EULA). Use the scroll bar at the
right of the screen to read the agreement content.

4. When you understand and agree to the terms, choose | accept the terms in the license agreement, and
then click Next to continue.

The Choose Install Folder panel opens.
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Progress Corticon Studio 6.0.0.0 = >

Progress Corticon Studio Install and Work directory

3) Progress’

Please choose Install and Waork Directory

Progress”
Corticon”

o RN Install Directory | C:\Progress\Corticon 6.0
Studio

Restore Default Choose..

Work Directory | C:\Users\gsaintmaProgress\CorticonWork_5.0

Restore Default Choose..

Previous

5. Specify the installation location. The default location for the installation directory and the work directory are
as shown above. (For the work directory, the default subdirectory under Users is the current username.)
Either accept the default locations, or specify each preferred (and different) location.

6. Click Next.

7. The External eclipse configuration panel opens:

Progress Corticon Studic 6.0.0.0 = it
External eclipse configuration
3) Progress’

Do you want to configure Corticon Studio with external eclipse?

Progress’
Corticon”

Studio

Cancel Previous

* If you select Yes on this panel, the entry area for the External Eclipse location in which you want to
add Corticon Studio (in addition to a standard installation) is presented:
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Running the Corticon Studio installer wizard

Progress Corticon Studio 6.0.0.0 = *

External eclipse configuration

3 Progress

Do you want to configure Corticon Studio with external eclipse?

Progress’
Corticon
Cr 1-im @ fes

= T L.] d | O External eclipse location

Restore Default Choose...

Cancel Previous

Enter or browse to the location of the existing Eclipse 4.8 64-bit installation.
* If you leave the selection as No, a normal installation will proceed.

When you have decided which path to take, click Next to continue.

8. The Pre-installation Summary panel opens.
Progress Corticon Studic 6.0.0.0 = it

Pre-Installation Summary

:ﬁ Prcgress* Please Review the Following Before Continuing:

Product Name:
Progress Corticon Studio

Prog,ressﬁ.,— Install Folder:
Corticon’ C-\_60x\nome\Studio

Studio Work Directory:
C\_B0xwork_dinStudio

Disk Space Information (for Installation Target):
Required: 701,743,619 Bytes
Available: 66,375,970, 616 Bytes

Cancel Previous

Confirm that your installation location has adequate disk space for the Corticon Studio components as well
as at least 100 MB of workspace.
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9. Click Install to continue.

An installation status window opens to display the state of the installation process. When the process has
finished, the Install Complete panel opens.

10. Click Done to quit and close the installer.

The installation or update of Corticon Studio 6.0 is complete.

Performing silent installations of Studio

An unattended (silent) install requires that you first run an installation or updater in the installer wizard to capture
the selected options, and then use the captured response file on other targets to 'playback’ the responses into
the installer without any user interaction.

To perform silent installations for Corticon Studio:

1. Run the Studio installer with your preferred locations and options to capture a response file, using the syntax
installer.exe -r filewhere installeristhe preferred Studio installer, and £ile is the response
file you will reuse. For example, PROGRESS CORTICON 6.0 STUDIO WIN 64.exe -r
C:\CorticonStudio64 60.responses

2. On other target machines, access the Studio 6.0 installer executable and the response file.

3. On those machines, run the installer using the syntax installer.exe -i silent -f file where
installer is the Studio installer, and 7ile is your response file. For example,
PROGRESS CORTICON 6.0 STUDIO WIN 64.exe -i silent -f
C:\CorticonStudio64 60.responses.

Installing Corticon Studio plugins into an existing
Eclipse

These instructions apply when you want to install Corticon functionality into an installed 64-bit Eclipse IDE.

1. A Java Software Development Kit (JDK) is required for Corticon, not just a Java Runtime Environment
(JRE). If you do not have one installed locally, download and install a 1.7 or higher 64-bit version from the
Oracle Java website http://www.oracle.com/technetwork/java

Note: For the installation of the Corticon Studio plugins, you can use the JRE that Eclipse is using. In
Eclipse, choose Window > Preferences, then select Java > Installed JREs.

2. Download and perform a standard installation of Corticon Studio into a clean directory on the target machine.
This installation will provide the script and the required files for the integration into your target Eclipse
location.

3. Ina Command Prompt window at the Corticon Studio's [CORTICON HOME] /Studio location, check to
see whether JAVA HOME is set. If not, set JAVA HOME to the JDK root. For example: set
JAVA HOME=c:\jdk1.8.0_65

4. Confirm that neither the installed Corticon Studio or the target Eclipse are running.

22
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Increasing Corticon Studio memory allocation

5. In the Command Prompt, run the integration script in the form:

integrateCorticon.bat -install eclipse target

where eclipse_target is the root directory of the target Eclipse installation.

Eclipse installs its required plug-ins.

6. To ensure that Corticon Ruletests can locate javac to compile rules, add the path of the JDK to your PATH
as the default Java to use. For example:

set PATH=%JAVA HOME$\bin; $PATHS

7. Specify the Corticon work directory, the folder where you want Corticon to write its log and other temporary
files. For example:

set CORTICON WORK DIR=c:\corticon work dir

8. When the script successfully completes, restart the Eclipse session, and then verify the installation by
selecting the menu command Help > About Eclipse. Click Installation Details to confirm that Progress
Corticon Feature is installed.

9. Open a project, and then run a Ruletest. A successful run indicates that the Java compiler is being accessed
correctly.

The integrateCorticon script enables other functions:

COMMAND SYNTAX AND OTHER OPTIONS

Usage: integrateCorticon [OPTION] [TARGET ECLIPSE]
Manage installation of Corticon plugins in an Eclipse install

-install Install Corticon plugins in TARGET ECLIPSE
-uninstall Uninstall Corticon plugins from TARGET ECLIPSE
-update Update Corticon plugins in TARGET ECLIPSE
-updateParams Update Corticon plugins parameters in TARGET ECLIPSE
-help Display this message

Increasing Corticon Studio memory allocation

When working on large Rule Projects, you will get better performance by increasing the amount of memory
available to Corticon Studio.

To change Corticon Studio memory allocation after installation, do the following:
1. Edit the command file eclipse.ini located at [CORTICON HOME]\Studio\eclipse

2. Change (typically, increase) the xmx value (maximum memory setting). The default Xxmx setting is 2 gigabytes,
specified as Xxmx2g.

Note: For more about memory sizing, see KnowledgeBase article 46561
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Setting Studio to run in another language

You can specify a preferred language for Corticon Studio. the options are:
* English (en - default)

* French (fr)

* Japanese (ja)

* Portuguese (Brazilian) (pt BR)

* Spanish (es)

To set Corticon Studio to start in your preferred language:

1. On Windows 10, right-click on the Start menu item for Corticon 6.0 Studio, and then choose More > File
location.

2. Right-click on the shortcut Corticon 6.0 Studio, and then choose Properties.

3. Choose the Shortcut tab, and then add to the Target value with the language option, -n1 followed by a
language value, as shown setting ja for Japanese:

Securty Details Previous Versions
General Shortcut Compatibility

9 Corticon 6.0 Studio

Target type: Application

Target location: eclipse

Target: |-E':~:'-J'u:|me'-.Stu-:li-:n'-.Stul:Iil:u eclipseeclipse .exe nl ja |

Start in: |C:'-._EI]':-:'-hu:ume'-.Stuu:liu:u'-studiu:u'-eclipse |

Shortout key: | MNone |

Run: Mormal window e
Comment: |Japanese| |
Open File Location Change lcon... Advanced...

4. Click Apply, and then OK to set the change.
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Setting Studio to run in another language

When you start Corticon Studio its labels are in Japanese, as illustrated:

e workspace - ADC Database Connectivity/Medical.ecore - Corticon Studio

TrAILF) ARER(E) TES-RN) tESR(A) FOVDhRP) RN ETR) v EDW AJLTHH)
Hwi i | | 0 TR ()
oY IHERALE(S)
B IO . 82 = !
- & FATEILFA) Ctrl+B
v L@ ADC Database Connectivity FOPIHDELFE)
= sql =32 T HDENL W) >
E Determinefpproval .ers U= (N
FC Medical.ecore v e )
‘& ProcedurefApproval.erf
@ ProcedureApproval.ert ¥ FodzhhotEEEy)
B FuTEA-EIOM =TT IO (L.
do =N EPI L—EU)...

F0MT<(P)

DARLT—HR . AT
T -5 #:
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4

Installing Corticon Servers and Web Console

This section provides information about the installation procedures for the deployment and administration
components of Corticon Server as well as the web application server, Apache Tomcat, that is used by the Java
Server and the Web Console.

Note: IMPORTANT: Default application server - Corticon Server and Web Console install a standard Tomcat
distribution to help you quickly get started. This is a standard Tomcat distribution at the time of Corticon release.
It may not have the latest security patches or other security configuration changes recommended for production
use. When moving to production, it is recommended to deploy Corticon Server and Web Console to a supported
application server that you have supplied and secured. If you choose to use the bundled Tomcat in production,
you assume responsibility for applying Tomcat security patches and performing security configuration.

Note: Linux Installation - When you download and run the Linux server installer, you get shell (. sh) scripts
for start/stop and utility tools that correspond to the batch (.bat) scripts in a Windows installation.

There are several techniques for installing Corticon Server components:

* Running the Server and Web Console installer wizard on page 28, the typical use, which enables a complete
Corticon Server for Java, Corticon Server for .NET, and Corticon Web Console.

* Performing silent installations of Server components on page 32 that generates a file from an installer wizard
run to let you perform silent installations of Server components on other Windows machines.

* Performing command-line Linux installations of Server components on page 33 enables the Linux installer
to run from the shell as a command with parameters.

* Performing a manual installation of Server components: Corticon Server for Java and Web Console
are available in zip archives. Use them to manually install Corticon WAR files into a supported application
server on any supported platform. For details about installing Corticon into specific application servers, see
Corticon Server 6.X sample WAR installation for different Application Servers .
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Considerations for Authentication

Confirm that servers that will host Corticon Server installations are enabled for authentication, and that Decision
Service administrators have the credentials to deploy to those servers.

When you run the Corticon Server installer, the application server does not enable authentication by default.
To do so, see "Setting up authentication for secure server access" in the Web Services section.

For details, see the following topics:

* Running the Server and Web Console installer wizard
* Performing silent installations of Server components
* Performing command-line Linux installations of Server components

e Setting up Corticon .NET Server resources on an IIS server

Running the Server and Web Console installer wizard

The Server installer will install or update Servers and Web Console to 6.0.

Note: You can install Corticon Servers and the Web Console on a machine that has a previous version installed.
Where a previous version is installed, you must manage any port overloads that might result from running both
versions. However, an installed version of Corticon Server 5.2 or earlier on the target machine must be
uninstalled, then Corticon Server 6.0 installed. Consult with Progress Corticon Support or your Progress
representative to consider your migration strategies for existing assets before you take action.

To create or update an installation of Corticon Servers (Java and .NET) and Web Console 6.0:
1. On the target machine, access the Corticon 6.0 installers you downloaded.
2. To open the Progress Corticon Server Setup Wizard:

* For Windows, double click on: PROGRESS CORTICON 6.0 SERVER WIN 64.exe

* For Linux, run: PROGRESS CORTICON 6.0 SERVER LNX 64.bin

The installer opens in the installer wizard. The first installer panel opens with information about the installer.
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Running the Server and Web Console installer wizard

Progress Corticon Server 6.0.0.0 = >
Introduction

:h PI'OQI'ESSI InstallAmnwhere will guide yau through the installation of Progress
Cotican Server,

Itiz strongly recammended that vou quit all programs hefore
cantinuing with this installation.
Progress

Click the et buttan to proceed to the nest screen. fyau want to

Corﬂcon" change something on a previous screen, clickthe Previous' button.

Sprw[:, r fou may cancel this installation at any time by clicking the 'Cancel’
== buttan.

Previous

Note: If Corticon Server 6.0 is installed at any location on the target machine, an alert is posted that denies
permission to continue, as shown:

Error. Progress Corticon Server already installed *

|@| Progress Corticon Server 6.0.0.0 is already installed on
"%  your computer. To reinstall Progress Corticon Server
6.0.0.0, first uninstall the existing 6.0.0.0 installation.

Flease Uninstall Progress Coticon Sernver and try installing again.

You will be able to apply Server 6.0 service packs and patches. You can have other versions of Corticon
Server installed in distinct folders and they can run concurrently, although they must run on separate ports.

3. Click Next to continue.

The License Agreement panel opens.
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Progress Corticon Server 6.0.0.0

3 Progress’

Prog ressfi”
Corticon”

Server

License Agreement

Installation and Use of Progress Corticon Server Requires
Acceptance of the Following License Agreement:

End Uszer License Asresment

CAUTION: YOU SHOULD CAREFULLY READ THE FOLLOWING
TERMS AND CONDITIONS OF THIS end uvser license AGREEMENT
BEFORE IMSTALLING OR USING THE PRODUCT AND
DOCUMENTATION TO WHICH THIS AGREEMENT RELATES. BY
ACCEPTING THIS AGREEMENT YOU ARE CONSENTING TO BE
BOUND BY THE TERMS AND CONDITIONS CONTAINED
HEREIN AND ACKNOWLEDGING YOUF. AUTHORITY TO DO 80 ON
BEHALF OF YOUR COMPANY (IF APFLICABLE). IF YOU DO NOT
AGREE WITH THESE TEEMS AND CONDITIONE, DO NOT PROCEED

O | acoapt the terms of the License Agresment

@ i do NOT accept the terms of the Licenss Agresmant

4. After you have read, understood, and agreed to the terms of the End User License Agreement, choose |
accept the terms of the license agreement, and then click Next.

The Choose Install Folder panel opens.
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3 Progress’

Prog ressfi”
Corticon”

Server

Cancel

Corticon Server Install and Work Directory

Please choose install and work directory

Install Directory | C:\Progress\Corticon 6.0

Restore Default Choose..

Work Directory | C:\Users\gsaintma'Progress\CorticonWork_6.0

Restore Default Choose..

Previous

explicit path, or click Choose to browse to each preferred directory.

The default installation directories are shown. To specify preferred directories on each line, either enter the

Note: For Linux installations, the work directory path must not contain spaces.

6. Click Next.
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Running the Server and Web Console installer wizard

The Choose Server Components panel opens.

Progress Corticon Server 6.0.0.0 = it

3 Progress’

Progress’
Corticon”

After installation

Ser\ﬂ:r you need to deploy Corticon Server for .NET to IIS. See the

- ide for details.

Cancel Previous

7. Choose the one or more components you want to install at this time. Any components already installed are
chosen and grayed out. If you choose Corticon Server for .NETas one of the components, see the topic
Setting up Corticon .NET Server resources on an IS server on page 33 for further instructions.

Note: The Linux installer does not enable a Corticon Server for .NET installation.

Click Next.

8. If you selected the Java Server or Web Console, the Corticon Port Numbers panel opens.
Progress Corticon Server £.0.0.0 - x

Corticon Server Instance Port Numbers

3 Progress’

HTTF Paort :

ShutDown Port
Progress’
Corticon’

Server

Cancel Previous
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9. If any of the preferred ports conflict with existing applications, you can change them at this time to an integer
value from 1024 to 49151. Be aware that the documentation references these ports as though the default
values, as shown, were accepted. Consult with your system administrator to identify alternate ports you
might use, or to reset the ports on the conflicting applications.

Enter your preferred port numbers, and then click Next. The Pre-Installation Summary page opens.

10. Verify your selections in the Pre-Installation Summary panel. Nothing has happened yet so you can click
Previous to go back to a panel to make changes, or click Cancel to quit this installation procedure.

11. Click Install to continue. The installation status window opens. When done, the Install Complete panel
opens.

12 Click Done to complete the Corticon Server / Web Console installation and close the installer.

The installation and update of Corticon Servers and Web Console 6.0 is complete.

Note: Using an LDAP store for Web Console authentication - You can set up Corticon Web Console to
authenticate users using an LDAP server. See the topic "Using LDAP for Web Console authentication" in the
Web Console Guide.

Performing silent installations of Server components

An unattended (silent) install requires that you first run an installation in the installer wizard (Windows or Linux)
to capture the selected components and options, and then use the captured response file on targets on the
same platform to 'playback’ the responses into the installer without any user interaction.

Silent installations or updates for Corticon Server Components on Windows:

1. Run the Corticon Server for Windows installer with your preferred locations and options to capture a response
file, using the syntax installer.exe -r filewhere installeris the preferred Server installer, and
fileis the response file you will reuse. For example:

PROGRESS CORTICON 6.0 SERVER WIN 64.exe -r C:\CorticonServer 60 WIN.responses

2. On other target Windows machines, access the Server 6.0 installer executable and the response file.

3. Run the installer using the syntax installer.exe -i silent -f filewhere installeristhe
Server installer, and £ile is your response file. For example:

PROGRESS CORTICON 6.0 SERVER WIN 64.exe -i silent -f
C:\CorticonServer 60 WIN.responses

Silent installations or updates for Corticon Server Components on Linux:

1. Run the Corticon Server for Linux installer with your preferred locations and options to capture a response
file, using the syntax installer.bin -r filewhere installeris the preferred Server installer, and
fileis the response file you will reuse. For example:

PROGRESS CORTICON 6.0 SERVER LNX 64.bin -r
/usr/corticon/CorticonServer 60 LNX.responses

2. On other target Linux machines, access the Server 6.0 installer binary and the response file.

3. Run the installer using the syntax installer.bin -i silent -f filewhere installeristhe
Server installer, and £ileis your response file. For example:
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Performing command-line Linux installations of Server components

PROGRESS CORTICON 6.0 SERVER LNX 64.bin -i silent -f
/usr/corticon/CorticonServer 60 LNX.responses

Performing command-line Linux installations of Server
components

A command-line install runs a Linux installation in a command shell as a text command with parameters.

To perform command-line installations for Corticon Server components:

1. On a supported 64-bit Linux platform, access the downloaded Linux installer binary file,
PROGRESS CORTICON 6.0 SERVER LNX 64.bin

2. In a shell, run the binary with the console option. For example:

# ./PROGRESS CORTICON 6.0 SERVER LNX 64.bin -i console

3. Follow the prompts to complete the installation via the command-line.

Note: For Linux installations, the work directory path must not contain spaces.

Setting up Corticon .NET Server resources on an lIS
server

The runtime server for Corticon Server for .NET is Microsoft Internet Information Services (11S), a distinct setup
into which you install and update with the latest Corticon Server for .NET resources.

* Obtain an appropriate Corticon license for Corticon Server.

* Confirm that your target machine meets the system requirements. See System requirements on page 8
for more information.

* See the Progress Software web page Progress Corticon 6.0 - Supported Platforms Matrix for information
on supported .NET Framework and IIS.

See the instructions for "Web services on .NET" in the Web Services Guide.
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Uninstalling Corticon components

Uninstalling Corticon Studio or Corticon Server results in removing a complete major.minor version of those
products, including any service packs or hotfixes applied. It is not possible then to uninstall just a service pack
or hotfix.

Uninstalling Corticon Studio
To remove a version of Corticon Studio, do the following:
1. Close Corticon Studio.

2. Choose the Start menu Control Panel function Programs and Features, and then double-click on Progress
Corticon Studio 6.0.x to launch its uninstaller.

Note: You could initiate the same task directly by navigatingto [CORTICON HOME]\Uninstall Progress
Corticon Studio 6.0, and then running Uninstall Progress Corticon Studio 6.0.exe.

The installed files in the Studio's [CORTICON HOME] are removed. Files you created (including the complete
workspace) are NOT removed or replaced during this process.

If the Uninstaller program is unable to fully remove components (usually because they are open), it will display
messages, and might require a reboot to complete the process.

Uninstalling Corticon Server

The Corticon Server components -- Corticon Server for Java, Corticon Server for .NET, and the Corticon Web
Console -- use common installation directories. As such, you cannot choose to uninstall just selected components.
Uninstallation will remove all installed server components.

To uninstall Corticon Server on Windows:
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1. Stop Corticon Server.
2. Backup any files you want to retain.

3. Choose the Start menu Control Panel function Programs and Features, and then double-click on Progress
Corticon Server 6.0.x to launch its uninstaller.

Note: You could initiate the same task directly by navigatingto [CORTICON HOME]\Uninstall Progress
Corticon Studio 6.0, and then running Uninstall Progress Corticon Server 6.0.exe.

To uninstall Corticon Server on Linux:
1. Stop Corticon Server.
2. Backup any files you want to retain.

3. Inacommand shell, navigate to [CORTICON HOME]\Uninstall Progress Corticon Studio 6.0,
and thenrun Uninstall Progress Corticon Server 6.0.bin.

The installed files in the Server's [CORTICON HOME] are removed. Note that files you created are NOT removed
or replaced during this process. No server files in the [CORTICON WORK DIR] are removed.
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